# Table of Contents

**BAIRS Advanced - Pivots, Charts** ................................................................. 1  
Work with Pivots ................................................................................................. 1  
Create a Pivot ..................................................................................................... 1  
Add/Remove Totals to a Pivot .......................................................................... 5  
Add/Remove Totals and Subtotals to a Pivot .................................................... 8  
Create/Modify a Complex Pivot - Use Grouped &/Or Computed Items .......... 12  
Remove a Pivot Outliner .................................................................................. 20  
Modify the Orientation of a Pivot ................................................................. 21  
Sort Data in a Pivot ........................................................................................... 25  
Drill Anywhere in a Pivot ................................................................................ 28  
Drill Up in a Pivot ............................................................................................... 30  
Format a Pivot ..................................................................................................... 32  
Change a Label Name in a Pivot ..................................................................... 35  

**Work with Charts** .......................................................................................... 37  
Create a Chart ................................................................................................... 38  
Change the Chart Type .................................................................................... 41  
Modify Chart Properties ................................................................................... 44  

**Work with Filters** ........................................................................................ 49  
Understand Simple Filters .............................................................................. 50  
Understand Filter Dialog Box - Pre-Populated Items ..................................... 51  
Modify Values to Filter Boxes in Query View ............................................. 55  

**Understand HTML - Advanced Skills** ....................................................... 60  
Advanced: Apply/Remove Filter to the Results Section - HTML Format ........ 60  
Advanced: Add/Remove a Field to the Request Line - HTML Format ............ 70  
Advanced: Work with a Pivot in HTML Format .......................................... 80  
Advanced: Work with a Chart in HTML Format .......................................... 92
BAIRS Advanced - Pivots, Charts

Work with Pivots

The Pivot Section

Pivots are a powerful analytical tool for grouping, focusing, subtotaling, and organizing your financial data in practically any way that might be meaningful for your department. Pivots are particularly useful for answering ad-hoc questions.

Pivots resemble spreadsheets or cross tab reports. They have side labels, top labels, and facts. The side labels form the rows of your pivot, and the top labels form the columns. The side and top labels can consist of items such as org, fund, fiscal year, or flex. Facts represent the values displayed. They are quantifiable figures or dollar amount items such as balance, actuals, or encumbrances.

Data in a Pivot

A pivot is made up of data in the Results section. If you process a query and filter the results to only "Supply" and "Equipment" accounts, the pivot will reflect this filter as well. If you want a pivot that reflects only two funds, filter the query for those two funds. If a computed item is added to the Results section, the computed item will appear as one of the request items in the Catalog pane, and can be used in a pivot.

- Within a pivot, Side Labels form rows; Top Labels form columns and Facts show values.
- You can add multiple items to any outliner. For instance, you can put both "Org" and "Fund" into Side Labels.
- Items are ordered hierarchically in the sequence in which they appear in the outliner panels. Thus, if your Side or Top Labels had "Fund" followed by "Flex", the Fund(s) will appear and then the Flex within the Fund.
- Side and Top Labels consist of "text" items (e.g., fund, org, org description) or date items (e.g., fiscal year, accounting periods)
- Facts consist of figure items (e.g., balance, tempbudg amount)
- Facts are summed by default

Format a Pivot

The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the Pivot menu, the Format menu, the Formatting toolbar, and the right-click (PC Users) speed menu options.

Create a Pivot
Procedure

You run a report summarizing the expenses for 5 of your courses. Each course is designated with a different flexfield.

In this example, you will create a pivot to more easily analyze and compare what your department spent last fiscal year on these 5 courses.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | The report opens. In this example, you will go behind the Main Page and create a pivot of the data represented in this report.  
   Click the View button. |
| 2.   | The View drop-down menu appears.  
   Click the Section/Catalog option. |
| 3.   | The Sections and Catalog panes open. In order to create a meaningful pivot you need to be on Results or if available, Table.  
   Click the Table option. |
| 4.   | The Table opens. You want to create a pivot from the data in this table.  
   Click the Insert button. |
Step 5. The Insert drop-down menu appears.

Click the **New Pivot** option.

---

Step 6. The new section called Pivot appears in the Sections pane to the left. The Catalog pane displays the Table hierarchy. The Pivot outliner appears at the bottom of the screen, and the Document section is blank, available for the pivot.

The Pivot outliner has three panels, Row Labels, Column Labels and Facts.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.</td>
<td>We need to click and drag the <strong>Actuals</strong> item from the Catalog pane into the Facts panel of the Pivot outliner.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Actuals</strong> item.</td>
</tr>
<tr>
<td>8.</td>
<td>Drag the <strong>Actuals</strong> item to the Facts outliner.</td>
</tr>
<tr>
<td>9.</td>
<td>When <strong>Actuals</strong> appears in the Facts outliner, the Actuals data of the pivot, populates the Document section. The total Actuals expense is displayed.</td>
</tr>
<tr>
<td></td>
<td>In this example, we want to determine how much of the total expenses was associated with specific courses (designated by Flex). The &quot;Flex&quot; item in the Catalog pane must be drug to the Row Label outliner.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Flex</strong> item.</td>
</tr>
<tr>
<td>10.</td>
<td>Click and drag the <strong>Flex</strong> item into the Row Labels.</td>
</tr>
</tbody>
</table>
The simple pivot has been created. Each Flexfield has the 04-05 Fiscal Year expenses associated with that particular course.

For more detailed information about modifying pivots such as adding totals, sorting data, etc., continue with the "Work with Pivots" topics.

You can chart this pivot. See, "Work with Charts".

12. **End of Procedure.**

### Add/Remove Totals to a Pivot

For grand totals, click the "outside" side or top gray bar of the column or row that you want to display a grand total.

For subtotals, click one of the "inside" side or top gray bars of the column or row that you want to subtotal.

Grand totals appear at the very bottom of the pivot or to the far right. Subtotals appear at the bottom of the selected side label or to the right of the selected top label.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.</td>
<td>The simple pivot has been created. Each Flexfield has the 04-05 Fiscal Year expenses associated with that particular course. For more detailed information about modifying pivots such as adding totals, sorting data, etc., continue with the &quot;Work with Pivots&quot; topics. You can chart this pivot. See, &quot;Work with Charts&quot;.</td>
</tr>
<tr>
<td>12.</td>
<td><strong>End of Procedure.</strong></td>
</tr>
</tbody>
</table>
In this example, we will add and remove Totals associated with a previously created pivot.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | We have created a simple pivot and would now like to add Totals.  
      | Click the **Gray Bar** above the Flex Field column. |
| 2.   | Notice the Flexfield column is highlighted.  
      | Right-click the **Gray Bar** above the Flex column. |
| 3.   | The right click drop-down menu appears with many options.  
      | Click the **Add Totals** option. |
### Step 4
Notice our pivot now has a Total line.

### Step 5
We would like to remove the Totals from our pivot.

Click the **Total** field on your pivot.

### Step 6
Notice the word "Total" has a dark frame. On your keyboard, select the **Delete** key.
Training Guide

Add/Remove Totals and Subtotals to a Pivot

For grand totals, click the "outside" side or top gray bar of the column or row that you want to display a grand total.

For subtotals, click one of the "inside" side or top gray bars of the column or row that you want to subtotal.

Grand totals appear at the very bottom of the pivot or to the far right. Subtotals appear at the bottom of the selected side label or to the right of the selected top label.

Procedure

We have created a pivot showing the 3 month activity of two of our vendors. In this example, we will now add grand totals and subtotals to our pivot.
Step | Action
--- | ---
1. | The three column pivot appears. You want to add Grand Total to the pivot. Click the **Gray Bar** above the vendor column (the "outside" column).

Step | Action
--- | ---
2. | The column is highlighted. Right-click **Gray Bar** above the column.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>The right click drop-down menu appears. Click the <strong>Add Totals</strong> option.</td>
</tr>
<tr>
<td>4.</td>
<td>The Grand Total has been added to the pivot. You would like to Sub-Total the BFS Account column. Click the <strong>Gray Bar</strong> of the Account Code column (the &quot;inside&quot; column).</td>
</tr>
<tr>
<td>5.</td>
<td>Right-click the <strong>Gray Bar</strong> of the Account Code column.</td>
</tr>
<tr>
<td>6.</td>
<td>The right click drop-down menu appears. Click the <strong>Add Totals</strong> option.</td>
</tr>
<tr>
<td>7.</td>
<td>Notice that our pivot has both the <strong>Grand Total</strong> and the BFS Account Code <strong>Subtotals</strong>.</td>
</tr>
<tr>
<td>8.</td>
<td>We now would like to <strong>remove</strong> the Subtotal. Click the <strong>Subtotal</strong> field.</td>
</tr>
</tbody>
</table>
Step 9. Notice both Subtotal fields are highlighted.

Click the **Delete** key on your keyboard.

| Total | 605.79 |

Step 10. Notice that the Subtotal field is no longer present on your pivot. We are not going to delete the Grand Total.

Click the **Grand Total** field.

| Total | 14,593.03 |
Create/Modify a Complex Pivot - Use Grouped &/Or Computed Items

Procedure

You want to know your department's total expenses for the current year on your operations org and fund (12307 & 19900). You also want to see your expenses grouped into categories: "Salaries", "Benefits" and "Other".

For each of these categories, you would like to see the Temporary Budget, Expenses and the Working Balance.

In this example, we will create a pivot using a grouped column (3 grouped categories of expenses) and computed items (Working Balance). In addition, we will work with the pivot and change the name.

For more detailed information, see the "Work with the Results Section: 'Create Grouping Columns' and 'Create Computed Items'".
### Step 1
You have just finished creating a grouping column (Cost_Category) and a computed item (Working_Balance). You will create a pivot using these two new columns.

For more information, see "Work With The Results Section: 'Create Grouping Column's, and 'Create Computed Items'".

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have just finished creating a grouping column (Cost_Category) and a computed item (Working_Balance). You will create a pivot using these two new columns. For more information, see &quot;Work With The Results Section: 'Create Grouping Column's, and 'Create Computed Items'&quot;.</td>
</tr>
</tbody>
</table>

### Step 2
Click the **Insert** button.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>Click the <strong>Insert</strong> button.</td>
</tr>
</tbody>
</table>

### Step 3
The Insert drop-down menu appears. Click the **New Pivot** option.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>The Insert drop-down menu appears. Click the <strong>New Pivot</strong> option.</td>
</tr>
</tbody>
</table>

### Step 4
Pivot appears in the Sections pane on the left. You want to change the name of this pivot.

Click on Pivot. Right-click the **Pivot** option.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Pivot appears in the Sections pane on the left. You want to change the name of this pivot. Click on Pivot. Right-click the <strong>Pivot</strong> option.</td>
</tr>
</tbody>
</table>

### Step 5
The **Pivot** drop-down menu appears. Click the **Rename Section...** option.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>The <strong>Pivot</strong> drop-down menu appears. Click the <strong>Rename Section...</strong> option.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 6.   | The Section Label appears.  
You want to delete the highlighted label, "Pivot" and replace it with something more meaningful.  
Press [Delete]. |
| 7.   | The previous label has been deleted.  
Place your cursor in the Label field.  
Enter the desired information into the Label field. Enter "Working Balance". |
| 8.   | The Section Label name now reads: "Working Balance".  
Click the OK button. |
### Step 9
You are ready to construct your pivot. You will begin by using the Cost Category data that you created in a Grouping Column. You need to find it in the Catalog pane to the left.

Use the vertical **Scrollbar** in the Catalog pane.

### Step 10
Click on, highlight and drag the **Cost_Category** item, to the Row Labels panel of the outliner.

This data will become the rows of your pivot.
## Step 11

Notice that **Cost_Category** is now in your Row panel and is displayed in the document section of the screen.

You want to change the order of your items, with Salaries being the first of the rows.

Select and highlight **Salaries**.

## Step 12

Drag **Salaries** to the top of the list.
13. Notice that Salaries is now the top of the list.

Click the vertical Scrollbar in the Catalog pane so that you can locate the items that need to go into the Facts panel of the outliner.

14. Drag Tempbudg into the Facts panel of the outliner.

15. Notice that Tempbudg is in the Facts panel of the outliner. Tempbudg also appears in the Document section.

Notice the pivot needs some basic formatting, there is not enough space for the full temporary budget value.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.</td>
<td>User the <strong>cursor</strong> to move the width of the Tempbudg column (the vertical line at the top of the pivot).</td>
</tr>
<tr>
<td>17.</td>
<td>The Tempbudg column will now accommodate the entire value. You need to add <strong>Actuals</strong> to the Facts panel of the outliner. Highlight the Actuals item.</td>
</tr>
<tr>
<td>18.</td>
<td>Drag <strong>Actuals</strong> to the Facts panel.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>19.</td>
<td>Notice the Actuals are now part of the pivot. You want to add the Catalog item, &quot;Working_Balance&quot; to your pivot. Click the vertical <strong>Scrollbar</strong> in the Catalog pane.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>20.</td>
<td>Click on and highlight <strong>Working_Balance</strong>.</td>
</tr>
<tr>
<td>22.</td>
<td>Notice that <strong>Working_Balance</strong> is now part of the pivot, although the field for the Working_Balance is too small to contain the entire Working Balance value. Use your <strong>cursor</strong> to increase the width to the Working Balance column at the top of the Pivot.</td>
</tr>
<tr>
<td>23.</td>
<td>Notice that the Facts outliner has three values listed. Items are ordered hierarchically in the sequence in which they appear in the outliner panel.</td>
</tr>
<tr>
<td>24.</td>
<td>You would like to total the expense categories. Click the <strong>Gray Bar</strong> above the categories column.</td>
</tr>
<tr>
<td>25.</td>
<td>The column is highlighted. Right-click the <strong>Gray Bar</strong> above the categories column.</td>
</tr>
<tr>
<td>26.</td>
<td>The right click drop-down menu appears. Click the <strong>Add Totals</strong> option.</td>
</tr>
<tr>
<td>27.</td>
<td>You have created a pivot using grouped columns and a computed item.</td>
</tr>
<tr>
<td>28.</td>
<td><strong>End of Procedure.</strong></td>
</tr>
</tbody>
</table>

**Remove a Pivot Outliner**

**Procedure**

In this example, we will remove an item (Working_Balance) from the Facts outliner.
### Modify the Orientation of a Pivot

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | **You have created a pivot and would like to delete a Working_Balance from the Facts panel of the outliner.**  
   **Click on Working_Balance in the Facts outliner pane.** |
| 2.   | **Notice that Working_Balance is highlighted in the Facts outliner.**  
   **Right-click on working_Balance.** |
| 3.   | **The right click drop-down menu appears.**  
   **Click the Remove option.** |
| 4.   | **Notice the Facts outliner and pivot no longer have Working_Balance.**  
   **End of Procedure.** |
In this example, we want to move (pivot or swing) the rows of this simple pivot, thus move the side labels to the top, in an effort to better display our results.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have created a simple pivot and want to move the side labels. Click the <strong>Gray Bar</strong> above the Flex column.</td>
</tr>
<tr>
<td>2.</td>
<td>The column is highlighted and there is a <strong>handle</strong> at the bottom of the column.</td>
</tr>
</tbody>
</table>
### Step 3

Drag and release the column **handle** to the right.

![Diagram showing the column handle being dragged]

### Step 4

Notice the results of your action. The side labels (Flex) have been moved to the top of the pivot, creating a different view of the information.

Notice also that the Flex has been moved to a corresponding panel of the outliner.

![Diagram showing the updated view of the information]
### Step | Action
---|---
5. | You now want to return to your original pivot format. Click the **Gray Bar** of the Flex row.

### Step | Action
---|---
6. | The Flex column is highlighted and the handle appears on the Flex row. Click on the **handle** and drag it to the left to its original position, thus changing the orientation of this pivot.

7. | You have returned the pivot to its original position.

### Step | Action
---|---
8. | **End of Procedure.**
Sort Data in a Pivot

You can sort labels (rows or columns) using the Ascending or Descending icons on the Sort line.

Procedure

We have created a pivot with data associated with Vendor, BFS Account and Expense or Encumbrance.

In this example, we will explore the pivot sort function and sort the vendor column changing the sort order of our vendors in order to better display the data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Our pivot has been created and we would like to sort the vendor column. We first need to open our Sort line. Click the <strong>Sort</strong> button.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
2. | The sort toolbar opens with the columns available to sort.
   | You may select different Sort options.
   | Click the Sort drop-down button.

Step | Action
--- | ---
3. | In this example, there are two sort options displayed (Vendor and Account Code).
   | In this example, we are going to leave the default value, **Vendor Name**.
Step 4. Notice that this pivot is sorted by Descending order, showing the items in descending alphabetic order beginning at the start of the alphabet.

We now want to have the vendors sort in ascending order.

Click the **Ascending Order** option.

Step 5. Notice that now the Vendor column is sorted in ascending order, beginning at the end of the alphabet and going up.

Notice also that the Grand total and Subtotals reflect this change in the sort order.
Drill Anywhere in a Pivot

If you want to see more detail behind a particular label (row or column) on a pivot, you can get to that data using the Drill Anywhere feature. For example, you might have a pivot listing vendors and associated BFS accounts and expenses. You would like to detail what type of transactions are represented on your pivot. The Drill Anywhere feature would provide you the ability to combine a variety of data elements in meaningful ways.

Procedure

In this example, we will **Drill Anywhere** in order to obtain the Transaction Types associated with the documents displayed on this pivot.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>A simple pivot has been created, for a three month period, including the Vendor name, BFS Account Code and Document ID. We want more information about transactions associated with a specific vendor. We will use the <strong>Drill Anywhere</strong> feature.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>2.</td>
<td>Click the <strong>Vendor</strong> Name.</td>
</tr>
<tr>
<td>3.</td>
<td>Notice Vendor Name is highlighted (as shown with dark border). Right-click the <strong>Vendor</strong> Name.</td>
</tr>
</tbody>
</table>

![Image showing the right-click drop-down menu]

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>The right click drop-down menu opens. Point to the <strong>Drill Anywhere</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Press <code>[I]</code>.</td>
</tr>
</tbody>
</table>
### Training Guide

**Financial Systems**  
**User Support**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 5.   | The Drill Anywhere drop-down menu appears.  
  Click the **Final_Transaction_Type** option. |
| 6.   | Notice the selected label (Vendor) is now broken down by the item we selected (Final Transaction Type).  
  In the outliner, the drilled item is added to the appropriate panel, and a drill-bit icon appears before the drilled item. |
| 7.   | **End of Procedure.** |

---

### Drill Up in a Pivot

#### Procedure

After you have used the Drill Anywhere feature, you might want to restore the pivot to its original state. You can do this using the Drill Up feature.
In this example, we will select one of the Transaction Type items and Drill Up. This will eliminate the Transaction Type column, returning the pivot to the original configuration.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>In this example, we want to select an item in the Transaction Type column. Click the <strong>PO</strong> item.</td>
</tr>
<tr>
<td>2.</td>
<td>Right-click the <strong>PO</strong> item.</td>
</tr>
<tr>
<td>3.</td>
<td>The Right click <strong>PO</strong> item drop-down menu appears. Click the <strong>Drill up</strong> option.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
4. | Notice that although you only selected one Transaction Type item, the entire drilled item column disappears.

5. | **End of Procedure.**

**Format a Pivot**
The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the Pivot menu, The Format menu, the Formatting toolbar, and the right-click (PC Users) speed menu options.

Procedure

In this example, we will format the label, "Womens Faculty Club". We will modify the font and the placement within the Vendor column.

Step | Action
--- | ---
1. | The simple pivot has been created. Click the **Vendor** Name.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The Vendor name is highlighted.</td>
</tr>
<tr>
<td></td>
<td>Right-click the <strong>Vendor</strong> Name.</td>
</tr>
<tr>
<td>3.</td>
<td>The right click drop-down menu appears.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Font...</strong> option.</td>
</tr>
</tbody>
</table>

![Diagram of Font dialog box]

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>The Font dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Italic</strong> option.</td>
</tr>
<tr>
<td>5.</td>
<td>Click the <strong>Underline</strong> option.</td>
</tr>
<tr>
<td>6.</td>
<td>You are also able to change the Font style and size, if you desire.</td>
</tr>
<tr>
<td></td>
<td>In this example, we will leave those items at the default setting.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
7. Notice the modifications to the font. You also want to modify the placement within the pivot.

Right-click the **Vendor** name.

8. The right click drop-down menu appears.

Point to the **Justify** option.

9. Click the **Center** option.

10. Notice the Vendor name is now centered along the horizontal field.

You want it to be vertically centered as well.

Right-click the **Vendor** Name.

11. Point to the **Justify** option.
Step | Action
--- | ---
12. | Click the Middle option.

Step | Action
--- | ---
13. | Notice your pivot Vendor Name has been formatted and centered in the Vendor column field.

**Change a Label Name in a Pivot**

**Procedure**

In this example, we will change the name of the Vendor.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Review your pivot. Double click <strong>Vendor</strong> Name.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The Set Label Item dialog box appears. Highlighted is the current label name (Womens Faculty Club). Press <strong>[Delete]</strong>.</td>
</tr>
<tr>
<td>3.</td>
<td>Enter the desired information into the <strong>Label</strong> field. Enter &quot;<strong>Faculty Club</strong>&quot;.</td>
</tr>
</tbody>
</table>
### Step 4
Notice the new name is present.

Click the **OK** button.

---

### Step 5
The Vendor name has been changed.

---

### Step 6
**End of Procedure.**

---

### Work with Charts
You can present data visually by creating a chart. Charts can demonstrate with a picture how much money you have spent on staff salaries and staff benefits. A chart can indicate spending of funds across accounting periods, or visually represent missing flexfields in transactions across orgs.

A chart is made up of data in the Results section. If you process a query and filter your results to only "Supply" and "Equipment" accounts, your chart will reflect this filter as well. If you want a chart that reflects only two funds, filter your query for those two funds. If you add a computed item in the Results section, the computed item will appear as one of the request items in the Catalog pane for the chart and you can use it in your chart.

The chart outliners consist of three panels: Y-Facts, Z-Categories and X-Categories.

**Y-Facts**
• Consist of quantifiable figure items (e.g., balance, tempbudg amount)
• Make up the graphical elements (e.g., bars, lines) in the chart
• Make up the y-axis, which runs vertically on all charts, except horizontal and pie charts. On horizontal charts, the y-axis runs vertically, and on pie charts the items placed in Y-Facts, make up the pie
• Are summed by default, but this can be changed

Z- & X-Categories

• Consist of non-quantifiable items, such as "text" items (e.g., fund, org, org description) or date items (e.g., fiscal year, accounting period)
• "Divide" or "split" the Y-Facts by the items placed in these outliners

Z-Categories

• Make up the z-axis, which runs back or "into" the chart, creating a 3-dimensional feel to most charts
• Are not available for pie charts

X-Categories

• Make up the x-axis, which runs horizontally on all charts, except horizontal and pie charts. On horizontal charts, the x-axis runs vertically, and on pie charts the items placed in X-Categories make up the slices of the pie
• You can add multiple items to any outliner
• Items are ordered hierarchically in the sequence in which they appear in the Outliner panels. Thus, if you have org followed by fund, the org(s) appear first and repeat for each matching fund

To rearrange the order of items in/or between an outliner, click and drag items until they are in the order you want. The chart changes accordingly.

The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the various menus and toolbars.

Create a Chart

Procedure
We have run a summary report of the cost of five classes for a fiscal year and would like to create a chart showing the results.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | You have run the report and are on the Table view. You now want to create a chart of this data.  

Click the **Insert** button. |

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 2.   | The Insert drop-down menu appears.  

Click the **New Chart** option. |

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 3.   | The new section called Chart appears in the Sections pane. The Catalog pane displays the Table hierarchy. The Chart outliner appears at the bottom of the screen, and the Document section is blank.  

The Chart outliner has three panels: Facts (Stack), Depth and X-Axis. |
### Step 4

You want to enter the Actuals item into the Fact outliner panel.

Highlight and drag **Actuals** to the Fact pane.
Change the Chart Type

Different charts offer different ways to visually present data. Some charts are more meaningful than others for a particular set of data. Below are descriptions of some chart types and how you might use them.

Bar Charts

Bar charts can be either vertical or horizontal. Y-Facts items determine the height of each bar. Items placed in the X-Categories create one set of bars along the x-axis. Placing items in the Z-Categories creates a 3-dimensional look with bars behind each other along the Z-axis.

Vertical Cluster Bar Charts

This chart represents items in clusters side-by-side. When this chart type is selected, the Z-Categories outliner changes to Z-Cluster. Items placed in the Z-Cluster outliner, will determine what clusters together across the X-axis. Place items you want to compare in Z-Cluster. Place the item you want to compare "across" in X-Categories. The legend should be on Z to differentiate items in the cluster.

Pie Charts

The pie chart represents items in a pie shaped graphic. The Y-Facts make up the entire pie, which is divided into "slices" by items placed in the X-Categories outliner. Since pie charts are two-dimensional, Z-Categories are not available.

Stacked Bar Charts

Stacked bar charts can be either vertical or horizontal and offer a similar complexity as cluster bar charts. Stacked charts are useful for comparing across sums of several
When this chart type is selected, the Z-Categories outliner, changes to Z-Stack. Items placed in the Z-Stacked outliner stack on top of each other across the X-axis. The legend should be on Z to differentiate pieces of the stack.

**Line Charts**

Line Charts can be thought of as dots connecting the tops of the bar chart. These charts are effective for showing highs and lows in a continuum. Items placed in the Y-Facts determine the position of the dots. Items placed in the X-Categories will create one line. Place items in the Z-Categories to create multiple lines.

**Bar-Line Charts**

Bar-line charts are useful for comparing multiple facts items in one chart. The first item placed in the Y-Facts determines the height of the bars. The second item placed in the Y-Facts determines the position of the dots on the line. X-Categories itemize the bars and line markers. You can make this chart 3-dimensional as well, but clarity is reduced as items are added to the Z-Categories.

**Area Charts**

Area charts are similar to line charts, but with the area under the line filled in. Items placed in the Y-Facts determine the "tops" of the area. Items placed in the X-Categories create one area segment. Place items in the Z-Categories to create multiple area segments.

**Stacked Area Charts**

Area charts can be stacked in the same way as bar charts. Items placed in the Y-Facts determine the "tops" of the area. Items placed in the X-Categories create the continuum you will compare across. When this chart type is selected, the Z-Categories outliner changes to Z-Stack. Items placed in the Z-Stack outliner, stack on top of each other across the x-axis. The legend should be on Z to see the sum of items.

**Ribbon Charts**

Ribbon charts are also similar to line charts, only the lines are 3-dimensional "ribbons". Items placed in the Y-Facts determine the position of the line marker. Items placed in the X-Categories will create one ribbon. Place items in the Z-Categories to create multiple ribbons.

**Procedure**

In this example, we will change the chart type.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | Currently the chart is a vertical bar chart and we would like it to be a pie chart.  
      | Click the **Format** button. |
| 2.   | The Format drop-down menu appears.  
      | Point to the **Chart Type** option. |
### Modify Chart Properties

**Procedure**

In this example, we will modify this chart by including the percentage of the value, highlighting a segment and then renaming the chart.

#### Step 1
We need to select a segment of the chart.

Click a **segment**.
2. Notice the segment is highlighted with a broken line around it. Right-click on this segment.

3. The right click drop-down menu appears, with default of "Show Pie Value". Click the Show Pie Percentages option.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Notice the percentage of the value is displayed, as well as the value. We would now like to highlight the very small value (1%), by pulling out the slice. Click the <strong>segment</strong>.</td>
</tr>
<tr>
<td>5.</td>
<td>Right-click the <strong>segment</strong>.</td>
</tr>
<tr>
<td>6.</td>
<td>The right click drop-down menu appears. Click the <strong>Pull Out Slice</strong> option.</td>
</tr>
<tr>
<td>7.</td>
<td>Notice that you have modified the chart.</td>
</tr>
</tbody>
</table>

---

**Step** | **Action**
---|---
8.   | We will now rename our chart. Click **Chart** in the Sections pane on the left. |
9.   | Right-click **Chart**. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.</td>
<td>The right click drop-down menu appears. Click the <strong>Rename Section...</strong> option.</td>
</tr>
<tr>
<td>11.</td>
<td>The Section Label dialog box opens. The present name is highlighted. Press <strong>[Delete]</strong>.</td>
</tr>
<tr>
<td>12.</td>
<td>Enter the desired information into the <strong>Label</strong> field. Enter &quot;04-05 Course Expenses&quot;.</td>
</tr>
<tr>
<td>13.</td>
<td>Click the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
### Step 14
Notice you have modified the chart (included percentages, highlighted a slice) and have changed the name.

![Pie chart showing modified data]

### Step 15
You now want to delete this chart.

**Right-click 04-05 Course Expense (chart) in the Sections pane.**

![04-05 Course Expense in the Sections pane]

### Step 16
The right click drop-down menu appears.

**Click the Delete Section... option.**

![Delete Section option in the drop-down menu]
### Work with Filters

The Filter line of BAIRS reports are pre-populated with items. These items have filters applied to them that will restrict the data returned in the Results section. Examples of filters include data associated with only one fiscal year, data for three accounting periods, and data for a range of org codes.

You can accept the filter line items as they are set, add new items to the Filter line, or change the limits of the pre-populated items.

Whether you add an item, change one, or accept the filter line as is, a Filter dialog box appears and prompts you to set a filter for that particular item or for the items with variable filters.

Three terms to focus on with the Filter dialog box are: Item, Logical Operator, and Values.

**Items** are analogous to column fields in the database table. Examples of items include Org, Fund, and Transaction Type. The item you are filtering appears in the title bar.

The **logical operator** defines the relationship between the values of a particular item. For instance, if you want to see all the data for org code 12300, you would select the operator "Equal". If you want to see data for org codes 12300 through 12305, you would select "Between".

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 17.  | The Delete Section box appears, asking: "Are you sure you want to delete 04-05 Course Expenses?"
|      | Click the **Delete** button. |
| 18.  | The chart is no longer present. |

**End of Procedure.**
Values are the data of a particular item. For instance, for Business Unit, the values are 1 and J. For Accounting Period, the values are 0 to 12. Items with a small number of possible values have a list to make data entry easier. Other items have no values listed, and you must add them.

Some items have "Keys" at the top of the Filter dialog box, which translate database values into everyday language. For example, the Accounting Period filter translates period numbers into months (i.e., 1=July, 2=August, etc.).

Selecting values:

To select one value, click on it.

To select two or more adjacent values, click the first value and simultaneously press the Shift key and click the last value you want.

To select two or more non-adjacent values, click the first value and simultaneously press the Control key and click the other value(s) you want until all the values you want are selected.

For additional information see, "Add a Simple Filter to a Query", "Remove a Simple Filter from a Query".

Understand Simple Filters

Procedure

In this example, we will review parameters have been entered on the Main Page.
### Step 1

The Query view show the Metatopics, Request, Sort and Filter lines. In this example, you want to see the Fiscal Year specific in this query.

Point to the **Fiscal Year** option.

### Step 2

When you put your cursor over **Fiscal Year**, you will see what parameters are set for that particular item.

In this example, the Fiscal Year is set for 2005, which is displayed in the call out message for Fiscal Year.

### Step 3

**End of Procedure.**

---

**Understand Filter Dialog Box - Pre-Populated Items**

When you set filters for items on the pre-populated Filter line, the Filter dialog box that appears, generally has the options listed below. There are exceptions to this rule, such as Accounting Period in summary reports, which has a pre-set logical operator and so does not have the "Not" or "Ignore" options in the Filter dialog box.

### Procedure

In this example, we will explore the Filter dialog box options for pre-populated items on the Filter line.
We will also modify the filter line to display Fund 19900 only.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The <strong>Fund Filter dialog box</strong> appears when you drag the upper grey strip on the Fund column to the Filter line.</td>
</tr>
</tbody>
</table>

The Logical Operator in this example, defaults to "Equal". If you want to filter your request to see everything except the value, you would select the **Not** field.

You can customize your values by typing them into the Edit field, use the Green Check Mark to add the item to the Values field, or use the red X to eliminate the item from the Edit field.

The "Include Nulls" field, when checked, will allow blank Fund fields in the report to be displayed.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The <strong>Ignore</strong> button tells Hyperion to disregard limits for that item when retrieving data. For instance, if you click the Ignore button for Org, Hyperion retrieves data for all orgs that match your other limits and your authority. To cancel setting a limit, click the <strong>Cancel</strong> button.</td>
</tr>
<tr>
<td>3.</td>
<td>The <strong>Show Values</strong> button displays all the values to which you have authority to see. If you would like all values to appear on your Filter Line, use the <strong>Select All</strong> button. If you would like to remove an item, use the <strong>Remove</strong> button. The <strong>Custom Values</strong> button is the default button and allows you to key in individual items and this option will be used in this example.</td>
</tr>
<tr>
<td>4.</td>
<td>Click in the <strong>Edit</strong> Field.</td>
</tr>
</tbody>
</table>
### Step 5

Enter the desired information into the field. Enter "19900".

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.</td>
<td>Note, if you would like delete the item from the Edit Field, use the large red X.</td>
</tr>
<tr>
<td></td>
<td>In this example, however you would like to move the item (19900) to the Value Field.</td>
</tr>
<tr>
<td></td>
<td>Click the the Green Check Mark.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.</td>
<td>Notice the item 19900 appears in the Value field of the Fund Filter dialog box.</td>
</tr>
<tr>
<td></td>
<td>Click the OK button.</td>
</tr>
<tr>
<td>8.</td>
<td>Notice the Results have been filter to display 19900 Funds only.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
9. | **End of Procedure.**

Modify Values to Filter Boxes in Query View

Procedure

We did a query and "Ignored" the Fund, therefore not filtering the Fund Code.

We have changed our mind and in this example, we will add and remove values in the Filter box, thereby modifying the initial query filter.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1. | **Click the Fund Code item in the DIM COA Metatopic.**

**Fund Code**
Training Guide

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The Fund Code Filter dialog box appears. You will enter your value in the <strong>Edit</strong> field. Enter the desired information into the field. Enter &quot;<strong>19900</strong>&quot;.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>You want to move the value (19900) from the <strong>Edit</strong> field to the <strong>Value</strong> field. Click the <strong>Green Check Mark</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>The value 19900 is in the <strong>Value</strong> field. Notice that 19900 is highlighted, indicating that it is selected. In this example, you want to add another value. Click in the <strong>Edit</strong> field.</td>
</tr>
</tbody>
</table>
### Step 5
You want to add your new value in the Edit field.

Enter the desired information into the field. Enter "27075".

### Step 6
Click the **Green Check Mark**.

Note, if you use the red **X**, the value will be deleted from the Edit field.

### Step 7
Both Fund 19900 and 27075 appear in the Values field.

In this example, we realize that 19900 has been entered by mistake. We want to remove Fund 19900 from the Values field.

Click **19900** and highlight it.
Step 8.
Fund 19900 is highlighted.

Click the Remove button.

Step 9.
Notice that only Fund 27075 remains.

You need to highlight this value in order to add it to your Filter line.

Click on Fund **27075** and highlight it.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 10.  | Notice that Fund 27075 is highlighted.  
      | Click the **OK** button. |

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 11.  | As you review the DIM COA Metatopic, it appears as if both Fund Code and Org Code have been filtered.  
      | You now want to check if Fund 27075 has been added to the Filter line.  
      | Click the Filter line horizontal **Scrollbar.** |
12. You have scrolled along the Filter line. When you point to **Fund Code**, the call out value, **27075** displays.

13. Because you have modified the original query parameters, you will need to run the query again with the modified parameters.

   Click the **Process** icon on the Standard toolbar. When the query is processed, data is returned to the Results/Table section and the pre-built reports are populated with the modified data.

14. **End of Procedure.**

---

**Understand HTML - Advanced Skills**

**Advanced: Apply/Remove Filter to the Results Section - HTML Format**

Once a query is processed, data is returned to the Results section. Data appears in a single table. Items from the Request line make up the column headings. A row appears for each database record.
Data in the Results section is used to create pivots, charts, and tables. As such you can use the Results section, for example to apply local limits, format the numbers, or add a computed item. The changes you make in the Results section will be reflected in any pivots, charts, and/or tables you create from that document.

The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the various menus and toolbars.

Procedure

In this example, we will run the GL_Sum by Account L4 BUDSUM. We will then modify the data filter and show only those items associated with General Supplies (BudSum 550XX).

After reviewing our data, we will delete the modified filter.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>We review the report. We now want to go behind the Main Page and modify the Account L4 BUDSUM, to include only the <strong>550XX (General Supplies BUDSUM)</strong>. Click the View button.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 2.   | The View drop-down menu appears.  
|      | Click the View Pane option. |
| 3.   | The Sections pane opens. We want to further modify the results filter line.  
|      | Click the Results option in the Sections pane. |
### Step 4
The Results appear. Since we want to modify the **Account Level 4 Node**, we need to locate that column on the Results table.

Click the horizontal **Scrollbar**.

### Step 5
Click the **Account Level4 Node** column.

### Step 6
Notice the **Account Level4 Node** is highlighted.

Click the **Actions** button.
Step | Action
--- | ---
7. | The Actions drop-down menu appears. Click the **Filter** option.

8. | The Filter drop-down menu appears. Click the **Add/Modify...** option.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>The <strong>Filter dialog box</strong> appears and defaults to the Custom Values tab. If you had a great number of values, the Show Values tab might be of help. In this example, we will stay with the <strong>Custom Values</strong> tab. The Logical Operator in this example defaults to &quot;Equal&quot;. If you want to filter your request to see everything except the value you enter, you would select the <strong>Not</strong> field. You can customize your values by typing them into the Edit field, then use the + button (at the end of the Edit field) to add the item to the Values field or use the - key to eliminate the item from the Edit field. The &quot;Include Nulls&quot; field, when checked, will allow blank fields in the report to be displayed.</td>
</tr>
<tr>
<td>10.</td>
<td>You will type in the value that you would like to display. You want to further filter your results to only those items associated with General Supplies (<strong>BudSum 550XX</strong>). <strong>Click in the Edit field.</strong></td>
</tr>
<tr>
<td>11.</td>
<td>Enter the desired information into the <strong>Edit</strong> field. Enter &quot;550XX&quot;.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
12. | You want to move the value of 550XX from the Edit field to the Value field. 
   Click the + button.

13. | You have finished entering the new filter value, **550XX** (highlighted in the Values field). 
   Click the **Set** button.
14. The filtering process has been successful. Notice you have fewer data elements (rows) displayed. You want to review the Account Level 4 Node column.

Click the horizontal **Scrollbar**.

15. Notice that the 550XX filter has been applied to the results. The only item in **Account Level 4 Node**, are the rows of 550XX.

For additional information, see "Work With a Pivot in HTML Format", "Work With a Chart in HTML Format", and "Add a Field to the Request Line - HTML Format".
16. In this example, you have reviewed your data perhaps created a pivot or chart displaying these results, and you now wish to delete this filter. Click the **Account Level4 Node** option.

17. Notice that the Account Level4 Node is highlighted, with the filter parameter (**Filter: = 550XX**) displayed. Click the **Actions** button.
Step | Action
--- | ---
18. | The Actions drop-down menu appears. Point to the **Filter** option.  
19. | The Filter drop-down menu appears. Click the **Delete** option.
Advanced: Add/Remove a Field to the Request Line - HTML Format

Procedure

In this example, we will run a basic report in the HTML format from the Main Page.

We will add an item (The BFS Account - Short Description) to the Request line of the Query section. In this example, we will add only one item, although you may add multiple items.

For additional information see, "Work with the Query Section" and "Work with the Report Section".

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The report opens. After reviewing the data, you want to do advance work on this report. We will add an item (BFS Account - Short Description) to the results line of the query, as this item could not be specified from the Main Page of our report. You want to get behind the Main Page report. Click the View button.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 2.   | The View drop-down menu appears.  
       Click the **View Pane** option. |
| 3.   | The **Sections** pane is now available to the left.  
       The highlighted item to the left (in this case, Report sort order:"Org, Fund, Proj, Fle..." ) controls what is shown in the central, Contents pane.  
       In this example, the report Sort order by "Org, Fund, Proj..." is found in the center of the Header.  
       For detailed information, see "Understand Contents Panes". |
| 4.   | In this example, we would like to work with the Query section.  
       Click the **Query** option. |
5. The Query format displays. Notice the Catalog List (under the Sections pane) to the left.

Notice also that the **Request**, **Sort** and **Filter** panes are pre-populated with our selections/parameters from the Main Page.
### Step 6

In this example, we will expand the Table Catalog List and then add an item to the Request pane.

**Click the** **Tables** button.

![Image of Table Catalog List and Query format]

### Step 7

The Metatopics from the Query format are listed. The item we want is in the Dim COA ATTR Metatopic.

For additional information, see "Work With the Query Section".

**Click the** **DIM COA ATTR** button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 8.   | The Metatopics List **DIM COA ATTR** opens. We might need to scroll to find the item, **Account Short Desc**.  

Click the **Account Short Desc** item. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>Drag the item, <strong>Account Short Description</strong>, to the Request Line.</td>
</tr>
</tbody>
</table>

10. Note the **Account Short Description** is now on the Request Line.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.</td>
<td>The added item (Account Short Desc) is now on the Request Line. You will need to run (Process) the report again. Click the Main Page option in the Sections pane.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.</td>
<td>When you select the Main Page in the Sections pane, the Main Page appears in the Contents/Document pane. You want to run the report with the new request item. Click the Run Report button.</td>
</tr>
<tr>
<td>13.</td>
<td>The ”Reports are Ready to View” message appears. Click the OK button.</td>
</tr>
</tbody>
</table>
14. You would like to see if the Account Short Description has been added to the results.  
Click the **Results** option.

15. The Results are displayed in the Contents/Document pane.  
In order to see if you have really added the item, Account Short Desc, you might need to scroll to the end of the Results columns.  
Use the horizontal **Scrollbar** to scroll to the far right of the report.  
Notice you have added a new column, **Account Short Desc**.  

For more detailed information, see "Apply/Remove Filter to the Results Section - HTML Format" and "Work with a Pivot in HTML Format".
Step 16. Time passes and you now want to delete the item from the Request line.

Click in the **Account Short Desc** field.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td>The item, <strong>Account Short Desc.</strong> is highlighted in the Request pane. Click the <strong>Edit</strong> button.</td>
</tr>
<tr>
<td>18.</td>
<td>The Edit drop-down menu appears. Click the <strong>Delete</strong> option.</td>
</tr>
<tr>
<td>19.</td>
<td>Notice that the <strong>Account Short Description</strong> is no longer on the Request line. You must be careful which items you delete from the Request line, some items <strong>must</strong> be present. If you wanted to review the results, remember you would need to run the report with the modified Request items.</td>
</tr>
</tbody>
</table>
Advanced: Work with a Pivot in HTML Format

Procedure

Your department tracks specific course expenses by flexfield. Using flexfields, you can display, analyze and compare how much your department spent last fiscal year on the five largest courses you offer.

In this example, we will run a report highlighting the flexfields and then create a pivot from that HTML format report.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You report appears. You wish to create a pivot from this data. Click the View button.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
2. | The View drop-down menu appears.  
Click the **View Pane** option.

3. | Notice the Sections pane appears.  For more information, see *Understand Contents Pane*.  
Click the **Table** option.

4. | The Table format appears.  You want to create a pivot from this table.  
Click the **Actions** button.
### Step 5

The Actions drop-down menu appears.  
Point to the **Insert** option.

### Step 6

The Insert drop-down menu appears.  
Click the **Pivot** option.

### Step 7

The Pivot view appears, which includes the Sections pane, Catalog pane (Catalog List), Facts, Rows and Columns Pivot Outliners.  
For more detailed information, see "Work with Pivots".
8. Notice under Catalog List, Table is an item that can be expanded.

Click the **Table (Query)** button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>The Table List is ordered hierarchically in the sequence in which they appear in the Table. In this example, you want to see Expenses (Actuals). Click the <strong>Actuals</strong> option.</td>
</tr>
<tr>
<td>10.</td>
<td>Click and drag <strong>Actuals</strong> to the Facts panel.</td>
</tr>
<tr>
<td>11.</td>
<td>Notice that when you put Actuals in the Facts panel, the Actuals is displayed in the Contents/Document pane. For this example, you want to add the Flexfields to your pivot by selecting it and dragging it to the Rows panel. Click the Catalog List <strong>Scrollbar</strong>.</td>
</tr>
<tr>
<td>12.</td>
<td>Click the <strong>Flex</strong> button from the Catalog pane.</td>
</tr>
<tr>
<td>13.</td>
<td>Highlight and drag <strong>Flex</strong> to the Rows panel.</td>
</tr>
</tbody>
</table>
Step 14.

This is your simple pivot, showing the yearly expenses per course (as designated by Flexfield). For more detailed information, see "Work with Pivots".
### Step 15
We would like to Total the expenses.

Click the **Actuals Gray Bar** at the top of the column.

![Image of a financial system interface showing a table with columns labeled 'Date', 'Amount', and 'Flexfields'.]

### Step 16
The column of Flexfields is highlighted.

Click the **Actions** button.

![Image of a financial system interface with a highlighted column and a button labeled 'Actions'.]
17. The Actions drop-down menu appears. Notice there are many options open to you when you select the Action button.

Point to the **Add Totals** option.
### Step 18
The Add Totals drop-down menu appears, offering many options.

- Click the **Sum** option.

### Step 19
Notice the Flexfield actuals are totaled.

### Step 20
You want to rename this pivot.

- Click the **Edit** button.

### Step 21
The Edit drop-down menu appears.

- Point to the **Section** option.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.</td>
<td>The Section drop-down menu appears. Click the <strong>Rename...</strong> option.</td>
</tr>
</tbody>
</table>

Enter the desired information into the **Please enter the new section name:** field. Enter "Course Expenses - 04-05".

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.</td>
<td>Enter the desired information into the <strong>Please enter the new section name:</strong> field. Enter &quot;Course Expenses - 04-05&quot;.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>24.</td>
<td>Click the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
25. Notice that the name of the pivot has been modified.

If you would like to print, see "Run/Print/Save a HTML Format Report", in the BAIRS - Basic module.

In this example, we want to delete this pivot.

Click the **Edit** button.

26. The Edit drop-down menu appears.

Point to the **Section** option.
27. The Section drop-down menu appears. Click the **Delete...** option.

28. The Delete Section message appears. Click the **Delete** button.

29. Notice the pivot is no longer available. **End of Procedure.**
Advanced: Work with a Chart in HTML Format

Procedure

In this example, we will create a chart focusing on the expenses of our five largest courses (designated by flexfield). You are also able to create a chart from a pivot.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have finished reviewing your data. Click the <strong>View</strong> button.</td>
</tr>
<tr>
<td>2.</td>
<td>The View drop-down menu appears. Click the <strong>View Pane</strong> option.</td>
</tr>
</tbody>
</table>
### Step 3
Click the **Table** option in the Sections pane.

### Step 4
Notice the data in the Table appears.

Click the **Actions** button.

### Step 5
The **Actions** drop-down menu appears.

Point to the **Insert** option.
Step | Action
--- | ---
6. | The **Insert** drop-down menu appears. Click the **Chart** option.
7. | The Chart view appears which includes the Sections pane, Catalog pane (Catalog List), Fact (Stack), X Axis and Depth Chart Outliners. For more detailed information, see "Work with Charts".

---

Step | Action
--- | ---
8. | In order to build a chart, select values from the Table (expanded) list and drag them to the appropriate outliner. Click the **Table (Query)** button.
9. The Table items expand, showing the sequence of the ordered hierarchy. Click the **Actuals** option.

10. Drag the **Actuals** item to the Fact (Stack) outliner.

---

11. Notice that when you drag your item to the outliner, the chart begins to be constructed in the Contents/Document pane.

   Drag **Flex** into the X Axis pane.

   Click the vertical **Scrollbar** in the Catalog pane in order to locate Flex on the Table Catalog.

12. Click the **Flex** button.

13. Drag the **Flex** item to the X Axis pane.
Step | Action
--- | ---
14. | The chart displays the yearly actuals for your departments five largest courses (designated by the Flexfield).

In this example, we would like to change the type of chart we use.

15. | You review you chart and decide that a pie chart might be more effective at communicating your data.

Click the **Actions** button.

16. | The Actions drop-down menu appears. Notice the various options available.

Point to the **Chart Type** option.

17. | The Chart Type drop-down menu appears.

Click the **Pie** option.

18. | The pie chart has been created and may be refined.

19. | You have created a pie chart based on the GL_Sum_by Five_Chartfields report.

For additional information, see "Work with Charts".

**End of Procedure.**